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What Are Servers?

Servers are programs that allow PCs to share their resources (such as files and printers) across a 
network with other users.    Some examples of servers are:

Type of Server Use
FTP Server An FTP Server allows users to establish a connection for file transfer. 

LPD Print Server A Print Server provides a dedicated source of network print services by 
managing print jobs for printers connected to servers. 

SNMP MIB II Agent The SNMP MIB II Agent allows technically knowledgeable users (such as 
network administrators) to examine a PCs configuration information and other statistics. 

For information about the servers installed in Server Control, refer to the online help for the specific 
server.

Related Topics
What is Server Control?
What is a Session?

Introduction
Step-by-step instructions
Concepts



What is a Session?

A session is a name that you give to a group of servers.

Sessions are useful for grouping servers that you want to run regularly and for starting several servers 
for one function. Instead of starting each server individually, you can create a session that includes the 
needed servers. Opening the session starts all the servers.    All servers appear in the initial session.

Related Topics
What is Server Control?

Introduction
Step-by-Step Instructions
Concepts



View Server Status

Each server in Server Control has a status window that enables you to view messages about server 
activity and status. You can use this window to monitor network activity and to solve problems if they 
occur.    The status window for each server displays information differently from other server status 
windows.

Related Topics
View Server Activity and Statistics
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View Server Activity and Statistics

From the main window in Server Control, double-click the servers icon.

The servers status window appears, which displays information about the server.

Related Topics
View Server Status
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What is Server Control?

The Server Control application provides a consistent way for you to access and control all the servers 
on your PC in Windows. With the Server Control application, you can configure, start, stop, and monitor 
your PCs servers and create, open, and save sessions. The available servers appear as minimized 
icons in the main window.

Server Control might include the following servers, or only some of them, depending on the product you 
purchased:

· LPD Print Server. The LPD Print Server provides a dedicated source of network print services by 
managing print jobs for printers connected to servers.

· FTP Server. An FTP Server allows users to establish a connection to your system for file transfer.

· SNMP MIB II Agent. The SNMP MIB II Agent allows technically knowledgeable users (such as 
network administrators) to examine a PCs configuration information and other statistics. 

You can also use the SNMP Agent for Windows through Server Control.

Related Topics
What are Servers?
What is a Session?
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Using the Toolbar with Server Control

The Server Control main window displays a toolbar with commands for the servers along the top. You 
can use menu commands to perform the same actions as those in the toolbar. The following commands 
are available in the toolbar:

Use this button                         To do this

Create a new session.

Open an existing session.

Save a session.

Start the selected server.

Stop the selected server.

Configure the selected server.

Access information about a server.

Access online help.

Exit Server Control.

Related Topics
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Start a Server

1. Select the server's icon in the Server Control main window. 

2. From the toolbar, choose the Start button. 

--or--
From the Commands menu, choose Start server, where server is the name of the selected server. 

Once you have started a server, the word Active appears under the server icon. A server remains 
running until you stop it, or until you exit from Server Control.

Related Topics
Stop a Server

Introduction
Step-by-Step Instructions
Concepts



Stop a Server 

1. Select the server icon in the Server Control main window. 

2. From the toolbar, choose the Stop button.

--or--
From the Commands menu, choose Stop server, where server is the name of the selected server. 

After you choose Stop, the icon name contains the word Inactive.

Related Topics
Start a Server
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Configure a Server

1. Select the server in the Server Control main window.

2. From the toolbar, choose the Configure button.

--or--
From the Settings menu, choose Configure server, where server is the name of the selected server. 

A server-specific configuration dialog box appears. 

3. Provide the necessary information. The information you provide depends on the server. Refer to the 
online help for the specific server for complete details.

4. Choose OK.

Once the server is configured, you can start the server. You can also change configuration information 
for most servers after you have started them.

Related Topics
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Create a Session

1. From the toolbar in the Server Control main window, choose the new session button.

--or--
From the Session menu, choose New.

A New Session dialog box appears. 

2. From the Servers Not In Session list, select the servers to include in your session.

3. Choose Add.

The selected servers appear on the right side of the dialog box in the Servers In Session box.

4. If you want a server to be active when you open the session, select the Active check box for the 
server in the Servers In Session list.

5. In the Session Name box, provide a name for the session.

6. Choose OK.

The servers in your session that you marked as Active will start, and Server Control saves the 
session.

Once you have created a session, you can open it through the Session menu's Open command.

Dialog Box Items
Session name
Servers not in session

Add >>
Add all >>
<< Remove
<< Remove all

Servers in session

Related Topics
Open a Session
Save a Session
What is a Session?
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Open a Session

1. From the toolbar in the Server Control main window, choose the Open button.

--or--
From the Session menu, choose Open.

2. In the Available Sessions box, select the session that you want to start.

The Servers box lists the servers in the selected session.

3. Choose OK.

Dialog Box Items
Available sessions
Servers

Related Topics
Create a Session
Save a Session
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Start a Server Automatically

1. From the Windows Program Manager, select the Server Control icon.

2. From the File menu, choose Properties.

A Program Item Properties dialog box appears.

3. In the Command Line box, add the option
-s session-name.

For example, for a session named "startme" the command line would be

c:\pctcp\ctlapp -s startme
4. Choose OK.

Server Control now opens this session when you start the Server Control application.

Related Topics
Create a Session
Save a Session
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Save a Session

1. From the toolbar of the Server Control main window, choose the Save button.

--or--
From the Session menu, choose Save As. 

A Save Session As dialog box appears.

2. In the Session name box, type a name for the session.
--or--
Select an existing name.

3. Choose OK.

You can save a session while its server or servers are running. If you create a session, it is saved 
automatically.

Dialog Box Items
Session name
Session listbox

Related Topics
Create a Session
Open a Session
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Add a Server to the Current Session

1. From the Session menu of the Server Control main window, choose Modify Current Session.

A modify Session dialog box appears.

2. From the Servers Not In Session list, select a server to add.

3. Choose the Add button.
--or--
Choose the Add All button if you want to add all the available servers to your session.

4. If you want a server to start when you open the session, select the active check box column.

5. Choose OK.

The server now appears in the session.

Dialog Box Items
Servers not in session

Add >>
Add all >>
<< Remove
<< Remove all

Servers in session

Related Topics
Create a Session
Remove a Server from the Current Session
Save a Session
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Remove a Server from the Current Session

1. From the Session menu of the Server Control main window, choose Modify Current Session.

A Modify Session dialog box appears.

2. From the Servers in Session list, choose a server to remove.

3. Choose the Remove button.
--or--
If you want to remove all servers from the session, choose the Remove All button.

4. Choose OK.

The server no longer appears in the session. 

Dialog Box Items
Servers not in session

Add >>
Add all >>
<< Remove
<< Remove all

Servers in session

Related Topics
Add a Server to the Current Session
Create a Session
Save a Session
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Delete a Session

1. From the Session menu of the Server Control main window, choose Delete. 

A Delete Session dialog box appears.

2. Select a session to delete. 

3. Choose OK. 

4. Confirm your choice when you are prompted.

Dialog Box Items
Available sessions
Servers/Active

Related Topics
Create a Session
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The Session Menu

Use the Session menu to create, open, modify, and save sessions, and to exit from Server Control. 

Use this command To do this
New Create a new session.

Open Use a saved session.

Save Save a session.

Save As Save a session and give it a name.

Delete Remove a session from Server Control.

Modify Current Session Add or remove servers from the current session.

Exit Exit from Server Control.

Related Topics
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The Edit Menu

Use the Edit menu to make changes to text in configuration dialog boxes.

Use this command To do this
Cut Delete selected text. The deleted text is placed in the Windows Clipboard.

Copy Copy selected text to the Clipboard.

Paste Insert text from the Clipboard.

Clear Window Clear all text from the status window.

Related Topics
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The Commands Menu

Use the Commands menu to start or stop servers.

Use this command To do this
Start server Start the selected server.

Stop server Stop the selected server.

You need to select a server before you use these commands.

Related Topics
Introduction
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The Settings Menu 

Use the Settings menu to configure servers, show or hide the toolbar, and show or hide status 
messages.

Use this command To do this
Configure server Edit the configuration dialog box for the selected server.

Display Icon bar Select this option to display or hide the toolbar.

Display Status Bar Hide or show the one-line are at the bottom of the Server Control main window 
that displays information when you click and hold the mouse button or a toolbar 
button or menu command.

Related Topics
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Session
In Server Control, a session defines the servers that appear in the Server Control main window. All 
servers appear in the initial session.







Select from this list the 
servers to include in your 
session.

Choose to add a server to your session. The 
included servers appear on the right side of the
dialog box in the Servers In Session box.

Choose to add all the available servers to your 
session.

Enter a name for the session.

Lists the servers that will be included in your 
session. When you choose OK to close this 
dialog box, the servers in your session that you
marked as Active will start, and Server Control 
saves the session.

Lists servers in the selected session. A check 
mark in the Active column indicates that the 
server starts when the session opens.

Select the session you want from this list of 
existing sessions.

Lists the servers in the selected session.

Select from the list a server to remove from the
session.

Choose if you want to remove all servers from 
the session.

Select the session you want to delete.

Session: In Server Control, a session defines 
the servers that appear in the Server Control 
main window. All servers appear in the initial 
session.

Use this window to View messages sent from 
the print server.

Select the print session that you want Print 
Client to use.



account name: The name or word that identifes who is billed for 
this session on a computer system.

case sensitivity: The ability of a program to evalutate the difference
between the capitalized and non-capitalized versions of a character. 
Case sensitive programs treat for example, cat and Cat, as distinct 
items.

It matters how you enter file and variable names on a case sensitive 
operating system (such as the UNIX operating system). If you want 
to view a file named Cat, and you enter the characters cat,    the 
system displays the file named cat if one exists, or gives you an 
error message. It does not display a file named Cat. Case sensitivity
also effects the way that files are listed when sorted in alphabetical 
order.
.

filename conventions: A TCP/IP network usually contains 
computers that run different operating systems. Each operating 
system has different conventions for naming files. For example, both
the number and kinds of characters that can be used in a name are 
often subject to limits.

When you use some TCP/IP supported services such as telnet and 
ftp, use the filenaming conventions in effect on the host system to 
work with files that are on the host.

hostname: The name of a networked computer. 

The hostname is one form of the computers TCP/IP network 
address; the other is its complete numeric network address.You can 
access a computer by its hostname or its numeric network address.

toolbar: A group of buttons that appears below the menu bar. These
buttons let you gain access quickly to the application's features.

IP address: A number (in the form n.n.n.n    where each n is a value 
in the range 0 to 255) that uniquely identifies a networked computer 
that uses the TCP/IP communication protocol. (The Internet Protocol
is defined in RFC 791.)

MIB-II: The Management Information Base (MIB) database used by 
an SNMP MIB agent to store information about the network 
operations of your PC. MIB-II (or MIB version 2) is the second 
version of the Internet-standard MIB. RFC 1213 defines the format 
of MIB-II.

packet: A single network message with its associated header, 
addressing information, data, and optional trailer. Also known as a 
"frame" or "datagram".

password: A word or string of characters that you supply in order to 
login to another system on a network. Systems that accept the 
username "anonymous" often require you to provide your e-mail 
address as the password.

permissions: On UNIX systems, settings that control who has 
access to a file and what rights (read, write, or execute) are given. 
NFS uses UNIX-style permissions to control access to network files.



protocol window: Some OnNet applications support a window 
dedicated to displaying the interactions between your PC and the 
remote host (the protocol). You can display the window usually from a
View, Settings, or Options menu.

remote host: A networked computer that makes a service available 
to other computers on the network. Typical host services include 
transferring files, printing files, and managing logins from remote 
users.

SNMP community: A relationship between an SNMP agent and one 
or more SNMP management stations.

SNMP community name: A unique name shared by the members of 
an SNMP community.

SNMP message: A packet of data, consisting of an SNMP 
community name and SNMP commands and operands.

status bar: A message area, typically at the bottom of the application 
window, that provides information about the component that is currently 
selected, or the state of the application.

session: A session comprises the interactions between your PC and a 
remote host    beginning with the initial connection and ending when you
or the host explicitly disconnect. 

Some OnNet applications allow you to configure sessions, that is, 
automatically send parameters such as your username and password 
to the remote host..

session definition: The configuration settings for a particular session 
or host connection. A session definition might include such settings as 
the hostname of a computer on the network and your login name for 
that computer, as well as other values that you specify. The set of 
session parameters you can specify differs with each program.

TCP (Transmission Control Protocol): A Transport layer, connection-
oriented, end-to-end protocol that provides reliable, sequenced, and 
nonduplicated delivery of bytes to a remote or a local user. TCP 
provides reliable byte stream communication between pairs of 
processes in hosts attached to interconnected networks.

time out: A period of time when a connection between a PC and a    
host computer is allowed to be idle or unused, or when a PC can 
attempt to make a connection to a networked host.. 

When the time period elapses, the host closes the idle connection, or 
the PC reports that it failed to connect to a host.

UDP (User Datagram Protocol): A Transport layer, connection-less 
mode protocol providing a (potentially unreliable, unsequenced, and/or 
duplicated) datagram communication for delivery of packets to a remote
or a local user. UDP provides a procedure for a process to send 
messages to other processes with a minimum of protocol mechanism.

username: A name required for login to a remote system.

wildcard:    A character such as * or ? that represents one or more 
characters in a filename. In a network, each operating system supports 



its own wildcard characters and syntax. When you use wildcards on a 
remote host, follow the conventions that apply to that host.



Displays or hides additional elements of this dialog box.

Returns to the previous dialog box.

Displays the Open dialog box so that you can search for 
a specific file.

Cancels your selection(s) and close the dialog box 
without taking any action.

Closes the dialog box.

Exits the application.

Displays Help about the contents of this dialog box.

Does not proceed as indicated.

Proceeds to the next dialog box.

Confirms your selection(s) and close the dialog box.

Opens the Options dialog box.

Enter a word or string of characters to log in to another 
system, workgroup, or domain on a network.

Protects the contents of the file from modification.

Starts the operation.

Stops the operation.

Starts or stops the operation.

Enter the hostname or IP address of the 
remote host that you are trying to reach.

Enter the name that you use to log in to a computer on a 
network.

Proceeds as indicated.

Proceeds as indicated and avoids further prompts for 
confirmation.

Click this to set up options,

Saves all the changes you have 
made without closing the dialog box.

Context-sensitive help for this 
item is not yet implemented.

Help for this dialog box is not yet implemented.





Technical assistance

Users in the U.S. and Canada, and worldwide resellers    Contact FTP Software®:

Telephone: (800) 382-4387
(508) 685-3600

E-mail: support@ftp.com
Fax: (508) 794-4484

 or 

Users outside of the U.S. and Canada    Contact your local reseller.

Tip
For FREE online technical services, see:

World Wide Web: http://www.ftp.com
Anonymous Ftp Server: ftp.ftp.com
Bulletin Board System: (508) 684-6240 ( settings    8,N,1)
CompuServe: GO FTPSOFT (PCVENJ Section 8)




